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Übersicht     

Was ist Luminar? 

Bequem suchen, bewerten, Fotos 
gruppieren und vieles mehr ...

Bei Luminar 3 stehen deine Fotos im 
Mittelpunkt. Eine schöne Nutzeroberfläche 
bietet eine elegante Leinwand, auf der du 
alle Bilder ohne zusätzliche Ablenkungen 
genießen kannst. 

Deine Fotos automatisch nach Jahr, 
Monat und sogar Tag gruppieren. Einfach 
zwischen Bildern navigieren und 
sicherstellen, dass das perfekte Bild, das 
du suchst, immer zur Hand ist. 

Allen deinen Fotos in Sekunden den 
gewünschten Look geben. Die 
erforderlichen Änderungen an einem 
einzelnen Bild vornehmen. Und sofort alle 
Einstellungen mit einem Klick 
synchronisieren. 

Luminar 3 ist eine All-in-One-Foto-App, 
die alles bietet, was ein moderner Fotograf 
für die Fotobearbeitung benötigt. Luminar 
bietet erweiterte Steuerelemente, die 
einfach zu bedienen sind. Intelligente Filter 
wie Accent AI machen es einfach, in 
Sekundenschnelle ein großartiges Bild zu 
erhalten. 

Anwender profitieren außerdem von 
intelligenten Filtern und 
Rauschunterdrückung in Echtzeit. Mit 
adaptiven Arbeitsbereichen, die zum 
Aufnahmestil passen, passt sich Luminar 
an, um ein vollständiges Erlebnis zu 
bieten, das Unordnung und Komplexität 
vermeidet. Erlebe es noch heute unter 
www.skylum.com.

http://www.skylum.com/
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Neue & verbesserte Funktionen 
• Neu: Vollständig zerstörungsfreier 

Arbeitsablauf beim Bearbeiten deiner 
Fotos 

• Neu: Luminar Library Panel zum Anzeigen 
und Bearbeiten mehrerer Fotos 

• Neu: Einzelbildansicht, Galerieansicht und 
Filmstreifenansicht 

• Neu: Schnelle Synchronisierung von 
Einstellungen zwischen mehreren Bildern 

• Neu: Bewerte Bilder mit Sternen und 
markiere sie mit Farbetiketten 

• Neu: Bilder als Favoriten markieren oder 
ablehnen 

• Neu: Referenzierte Ordner immer synchronisieren 
• Neu: Filterung und Sortierung nach bestimmten 

Kriterien 

 

Die 10 
wichtigsten 
Vorteile 

• Neu: Intelligente Verknüpfungen zum 
automatischen Organisieren Ihrer Fotos 

• Neu: Luminar Photos Trash zum 
Bereinigen von Medien und Laufwerken 

• Neu: Quick Edits zum Bearbeiten einzelner Bilder 
• Neu: Brandneue Luminar Looks mit KI 
• VERBESSERT: Infopanel 

• VERBESSERT: Benutzerdefinierte Farbprofile (Windows) 

• VERBESSERT: Geschwindigkeitsverbesserung 
• VERBESSERT: Exportleistung (Windows) 
• VERBESSERT: Filtersteuerung (Windows) 

• VERBESSERT: Plug-In-Leistung (Windows) 
• VERBESSERT: Hilfemenü und Supportbereich 

 

1. Eine anpassungsfähige 
Oberfläche für ein 

angenehmeres Erlebnis 

2. Accent AI Filter - der intelligenteste Foto-Enhancer 
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der Welt 

3. Adaptive Luminar-Looks & 
kreative Nachschlagetabellen 
(LUTs) 

4. Präzise Rohformatbearbeitung 

5. Mit dem neuen 
Bibliotheksfenster werden Sie 
wirklich organisiert 

6. Schöne Bearbeitungen, 100% zerstörungsfrei 

7. Präzisionsanpassungen ohne 
Auswahl 

8. Luminar ist ein Teamplayer 

9. Einzigartige Anpassungen, die man 
nirgendwo anders findet 

100.% Plattformübergreifend und 
perfekt für den gesamten Haushalt 
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Erste 
Schritte    
Installation 

Luminar 3 wird aus einer einzigen DMG oder.exe Datei installiert. Um die Anwendung zu 
installieren, folge diesen Anweisungen: 
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Für Mac: 

1. Doppelklick auf Luminar_3.dmg, um 
das Installationsprogramm zu öffnen. 

2. Ziehe die Anwendung in 
deinen Programmordner 
(Applications). 

3. Wähle Gehe zu> Anwendungen (Go > 
Applications), um zu deinem 
Programmordner (Applications) zu 
navigieren. 

4. Suche die Luminar 3-Anwendung und 
Doppelklick zum Starten. 

5. Geben Sie Ihre E-Mail-Adresse 
und Ihren Aktivierungsschlüssel 
(aus Ihrer Aktivierungs-E-Mail) ein, 
u m d i e I n s t a l l a t i o n u n d 
Registrierung abzuschließen. 

6. Klicke auf Aktivieren 
(Activate), um die 
Anwendung zu starten. 

Für Windows: 

1. Doppelklick auf 
Luminar_3_Setup.exe, um das 
Installationsprogramm zu starten und 
den Installationsvorgang zu starten. 

2. Klicke auf Installieren, um das 
Installationsprogramm zu starten. 
Möglicherweise musst du dem 
Installationsprogramm die 
Berechtigung erteilen, um fortfahren 
zu können 

3. Wenn das Installationsprogramm 
abgeschlossen ist, lassen Sie das 
Kontrollkästchen für Luminar 3 
ausführen (Run Luminar 3) und 
klicke auf Fertigstellen (Finish). 

4. Überprüfe die 
Lizenzvereinbarung und stimme 
ihr zu. 

5. Gib die beim Kauf der Software 
verwendete E-Mail-Adresse und 
deinen Aktivierungsschlüssel ein, 
um die Installation und 
Registrierung abzuschließen. Die 
Anwendung ist jetzt einsatzbereit. 

6. Klicke auf Aktivieren 
(Activate), um die 
Anwendung zu starten. 
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Erste 
Schritte    
Luminar nutzen 
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Standalone / Host-Betrieb 

Luminar 3 kann als eigenständige 
Anwendung oder als Plug-In für folgende 
Host-Anwendungen verwendet werden: 

Windows & MacOS
● Adobe Photoshop 
● Adobe Lightroom Classic CC 

Nur MacOS
● Adobe Photoshop Elements 

● Apple Aperture 
● Photos für MacOS 

 

Du kannst auf Luminar 3 von vielen 
verschiedenen Hostanwendungen aus auf 
folgende Weise zugreifen: 

● Adobe Photoshop

○ Beim Bearbeiten eines Bildes: 
Filter> Skylum Software> 
Luminar 3 

● Adobe Lightroom Classic

○ Beim Anzeigen eines Bildes 
in den Bibliotheks- oder 
Entwicklungsmodulen 
(Library oder Develop 
modules): Klicke mit der 
rechten Maustaste auf das 
Bild > Bearbeiten in > 
Luminar 3 (> Edit In > 
Luminar 3) 

○ Wähle in der Menüleiste 
Foto > Bearbeiten in > 
Luminar 3 (Photo > Edit In 
> Luminar 3) 

● Apple Aperture

○ Wähle ein Bild aus, geh zu 
Fotos > Mit Plug-In bearbeiten 
(Photos > Edit with Plug-in), 
und wähle Luminar 3 aus 

● Photos für MacOS

○ Wähle ein Bild aus, klicken Sie 
auf Bearbeiten (Edit) und gehe 
zu: Erweiterungen> Luminar 3 
(Extensions > Luminar 3) 
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Nutzeroberfläche 
Rundgang  

Luminar 3 hat zwei Hauptansichten. Die Bibliotheksansicht (Library) dient zum 
Durchsuchen und Navigieren deiner Fotos. In der Bearbeitungsansicht (Edit) kannst 
du deine Bilder verbessern. Die Oberfläche ist intuitiv und leicht zu navigieren. 

Hinweis: Dieses Dokument soll eine kurze Übersicht sein und keine umfassende 
Hilfe. Ausführlichere Erklärungen, Anwendungsbeispiele und Videos findest du 
unterwww.skylum.com/luminar 

  

Bibliothekssymbolleiste (Library) 
Oben in der Bibliothek (Library) befindet sich die Bibliothekssymbolleiste. Hier sind die Knöpfe von links nach 
rechts: 
● Öffne das Tastenmenü. (Open Button Menu)
○ Bilder importieren in. (Import Images To.) Kopiert Bilder in einen Zielordner. 
○ Ordner hinzufügen. (Add Folder.) Füge deiner Luminar-Bibliothek einen vorhandenen Ordner 

auf deinem Computer hinzu. 
○ Bilder zum schnellen Bearbeiten öffnen. (Open Images for Quick Edit.) Bringe einzelne 

Bilder zur Bearbeitung in Luminar. 
● Navigationstasten. (Navigation Buttons.)
○ Nach oben navigieren. (Navigate Up.) Rufe einen Ordner in deiner Luminar-Bibliothek auf. 
○ Aktueller Ort. (Current Location.) Zeige den aktuellen Ordner an und navigiere 

zu benachbarten Ordnern in der Dateistruktur. 
● Schaltfläche anzeigen. (Show Button.) Öffnen und schließen des Seitenpanels 
● Vergrößerungstasten. (Magnification Buttons.)
○ Thumbnail Größe. (Thumbnail Size.) Eine Liste voreingestellter 

Vergrößerungsstufen für Miniaturansichten von Bildern beim Navigieren in der 
Rasteransicht. 

○ Verkleinern und Vergrößern. (Zoom Out and Zoom In.) Die Zoomstufe mit den Tasten + oder - 
einstellen. 

● Schaltflächen Anzeigen. (View Buttons.)
○ Bibliothek. (Library.) Bildordner und Alben durchsuchen. 
○ Bearbeiten. (Edit.) Ein Bild mit Filtern für ein perfektes Erscheinungsbild anpassen. 
○ Info. Die Metadaten eines ausgewählten Bildes anzeigen, um mehr über eine Datei zu erfahren. 

http://www.skylum.com/luminar
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● Bild teilen. (Share Image.) Dein Bild in andere Dienste oder Anwendungen exportieren. 
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Bibliothek Seitenpanel (Library Side 
Panel) 

Luminar verwendet eine Reihe von 
Verknüpfungen, Alben und Ordnern, um die 
Organisation deiner Bilder zu erleichtern. 

● Tastenkombinationen. (Shortcuts.) 
Schneller Zugriff auf Ihre Bibliothek mit einer 
Reihe praktischer Verknüpfungen. 
○ Alle Fotos. (All Photos.) Durchsuche 

deine Bibliothek nach Jahr, Monat oder 
Tag 

○ Favoriten. (Favorites.) Zeige alle deine 
Bilder an, die du als Favoriten ausgewählt 
hast (klick einfach auf das Herz-Symbol oder 
drücke P, wenn ein Bild ausgewählt ist). 

○ Kürzlich hinzugefügt. (Recently Added.) 
Sie können schnell Bilder anzeigen, die 
kürzlich zu Ihrer Bibliothek hinzugefügt 
wurden. 

○ Kürzlich bearbeitet. (Recently Edited.) 
Überprüfe kürzlich bearbeitete Bilder. 

○ Papierkorb. (Trash.) Überprüfedie Bilder, die 
Sie zum Löschen in die Warteschlange 
gestellt haben. Die Bilder können entweder 
gelöscht und zur Bereinigung in den 
Papierkorb verschoben oder in die Luminar-
Bibliothek zurückgegeben werden. 

● Alben. (Albums.) Platziere deine Fotos in 
virtuellen Sammlungen. Du kannst Bilder von 
einem beliebigen Ort oder Ordner aus 
auswählen. Das Hinzufügen und Entfernen hat 
keine Auswirkungen auf Ihre eigentlichen Dateien 
auf der Festplatte. Verwende besser ein Album 
wie du eine Wiedergabeliste nutzen würdest, um 
Musik zu organisieren. 

● Ordner. (Folders.) Ordner werden direkt an 
Ordner auf deiner Festplatte gebunden. 
Luminar arbeitet mit der realen Ordnerstruktur 
deiner Festplatte(n). 
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○ Master-Ordner. (Master Folder.) Wenn du 
einen Ordner auswählst, wird er deiner 
Ordnersammlung als oberster Ordner 
hinzugefügt. Alle darin enthaltenen Ordner 
werden ebenfalls hinzugefügt. 

○ Unterordner. (Subfolders.) Alle Ordner in 
einem Master-Ordner werden als 
Unterordner hinzugefügt. Zusätzliche 
Ordner innerhalb dieser Ordner werden 
ebenfalls hinzugefügt. Du kannst in Zukunft 
zu jedem Ordner weitere Unterordner 
hinzufügen, indem du mit der rechten 
Maustaste auf einen Ordner klickst und den 
Befehl Neuer Unterordner (New 
Subfolder) auswählst. 
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Bearbeitungssymbolleiste 
Oben im Bearbeitungsmodus befindet sich die Bearbeitungssymbolleiste. Hier sind die Knöpfe von links nach 
rechts: 

 

● Öffne das Tastenmenü. (Open Button Menu)
○ Bilder importieren in. (Import Images To.) Kopiert Bilder in einen Zielordner. 
○ Ordner hinzufügen. (Add Folder.) Füge deiner Luminar-Bibliothek einen vorhandenen Ordner 

auf deinem Computer hinzu. 
○ Bilder zum schnellen Bearbeiten öffnen. (Open Images for Quick Edit.) Bringe einzelne 

Bilder zur Bearbeitung in Luminar. 
● Navigationstasten. (Navigation Buttons.)
○ Nach oben navigieren. (Navigate Up.) Rufe einen Ordner in deiner Luminar-Bibliothek auf. 
○ Aktueller Ort. (Current Location.) Zeige den aktuellen Ordner an und navigiere 

zu benachbarten Ordnern in der Dateistruktur. 
● Schaltfläche anzeigen. (Show Button.)
○ Filmstreifen. (Filmstrip.) Ein dünner Streifen von Bildern am linken Rand, um 

Bilder in demselben Ordner oder in derselben Gruppe zu durchsuchen. 
○ Seitenpanel. (Side Panel.) Zugriff zu Bibliothek (Library panel), Bearbeiten (Edit) oder Info. 
○ Aktuelle Fotoaktionen (Current Photo Actions) Zeigt den Namen, die Bewertung und die 

Beschriftungen für das ausgewählte Bild an. 
● Luminar Looks anzeigen. (Show Luminar Looks.) Aktiviert den Looks-Browser für 

Voreinstellungen und Rezepte mit einem Klick. 
● Vergrößerungstasten. (Magnification Buttons.)
○ Thumbnail Größe. (Thumbnail Size.) Eine Liste voreingestellter 

Vergrößerungsstufen für Miniaturansichten von Bildern beim Navigieren in der 
Rasteransicht. 

○ Verkleinern und Vergrößern. (Zoom Out and Zoom In.) Die Zoomstufe mit den Tasten + oder - 
einstellen. 

● Vergleichstasten. (Comparison Buttons.)
○ Schnellvorschau. 

(Quick Preview.) Das 
Augapfelsymbol kann 
schnell zwischen dem 
ursprünglichen Bild und 
der verbesserten 
Version umschalten. 

○ Vergleichstaste. 
(Compare Button.) Diese 
Schaltfläche aktiviert einen 
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Vergleich, bei dem das Bild 
durch einen vertikalen 
Streifen 
(„Vorhang“ („curtain“)) 
geteilt wird. Das 
Originalbild (Vorher) wird 
links angezeigt, und das 
aktuelle Ergebnis 
(Nachher) befindet sich 
rechts. 
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● Menü Werkzeuge. (Tools Menu.)
○ Beschneiden-Werkzeug. (Crop Tool.) Mit dem Ausschneiden-Werkzeug 

kannst du Teile eines Bildes ausblenden, um die Bildkomposition zu ändern 
oder es für die Anzeige mit einer bestimmten Größe oder einem bestimmten 
Seitenverhältnis vorzubereiten. 

○ Free Transform Tool. Mit diesem Werkzeug können Sie eine Ebene ganz einfach 
transformieren. 

○ Klonstempel-Werkzeug. (Clone & Stamp Tool.) Mit dem Klonen & Stempeln-
Werkzeug kannst du Pixel von einem Teil des Bildes abtasten (halte die Wahltaste 
gedrückt und klicke auf die Quellpixel). Du kannst dann klicken und in einen 
anderen Teil des Bildes malen, um diese Pixel hinzuzufügen. 

○ Löschwerkzeug. (Erase Tool.) Dieses Werkzeug zeichnet auf unerwünschte Pixel, um diese zu 
entfernen. 

● Schaltflächen Anzeigen. (View Buttons.)
○ Bibliothek. (Library.) Bildordner und Alben durchsuchen. 
○ Bearbeiten. (Edit.) Ein Bild mit Filtern für ein perfektes Erscheinungsbild anpassen. 
○ Info. Die Metadaten eines ausgewählten Bildes anzeigen, um mehr über eine Datei zu erfahren. 

● Bild teilen. (Share Image.) Dein Bild in andere Dienste oder Anwendungen exportieren. 
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Seitenpanel (Side Panel) 
● Histogramm-Schaltfläche anzeigen/

ausblenden (Show/Hide Histogram 
Button): Zeigt oder verbirgt das 
Bildhistogramm, um Belichtung und 
Farbausschnitt besser beurteilen zu können. 

● Layer anzeigen/ausblenden (Show/Hide 
Layers Button): Blendet Ebenen zum 
Entwerfen zusammengesetzter Bilder mit 
Ebenenmasken und Mischmodi ein oder aus. 

● History-Schaltfläche. (History Button.) Luminar 
führt eine Liste der Aktivitäten, die du mit dem 
Bild gemacht hast, seitdem du es geöffnet hast. 
Dies sind mehrere Rückgängigmachungen und 
eine einfache Möglichkeit, die Zeit 
zurückzudrehen. Einfach auf einen früheren 
Verlaufsstatus klicken, um das Foto auf diese 
Bearbeitungsstufe zurückzusetzen. 
Verlaufszustände werden automatisch 
zusammen mit einem Bild in deinem Luminar-
Katalog gespeichert. 

● Histogramm (Histogram): Zeigt den gesamten 
Tonwertbereich deines Bildes von dunkel bis hell 
an. Durch Klicken auf die Pfeile in der oberen 
linken und rechten Ecke werden abgeschnittene 
Bereiche (reines Schwarzweiß) hervorgehoben. 

● Ebenen (Layers): Dies ist eine großartige 
Möglichkeit, deine Bearbeitungsaktivitäten so zu 
organisieren, dass das bestmögliche Bild erstellt 
wird, indem du verschiedene Effekte oder 
Bearbeitungsschritte auf separaten Ebenen 
platzierst. Jede hinzugefügte Ebene kann einen 
separaten Effekt-, Deckkraft-, Masken- und 
Überblendungsmodus haben. 

● Filter-Steuerungsmenü (Filters Control 
Menu): Steuert das Verhalten einer 
vorhandenen Filterebene oder erstellt eine neue 
Voreinstellung. 

● Schaltfläche Filter hinzufügen (Add Filters 
Button): Ruft den Filterbrowser auf, damit du 
alle in Luminar 3 enthaltenen Filter 
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durchsuchen und verwenden kannst 
● Arbeitsbereichsumschalter (Workspace 

Switcher): Ändert, welche Filter standardmäßig 
mithilfe der enthaltenen Arbeitsbereiche sichtbar 
sind. 

● Filtersteuerungen (Filter Controls): Passt 
die Eigenschaften für einen ausgewählten 
Filter an. Bewege die Maus über die 
Titelleiste, um die Steuerelemente für 
Sichtbarkeit und Maskierung anzuzeigen. 

● Luminar-Look-Button speichern (Save 
Luminar Look Button): Speichert die 
hinzugefügten Filter und ihre Eigenschaften 
als bearbeitbaren Luminar-Look. 
Benutzerdefinierte Looks sind eine 
hervorragende Möglichkeit, um beim Arbeiten 
Zeit zu sparen. 
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Andere Steuerelemente 
● Bildleinwand (Image Canvas): Das Ansichtsportal, in dem das Bild als Bearbeitung angezeigt wird. 
● Leinwand Hintergrund (Canvas Background): Du kannst die 

Hintergrundfarbe der Leinwand ändern, indem du Ansicht> Hintergrund> (Farbe) 
(View > Background > (Color)) wählst. Verschiedene Grautöne sorgen für einen 
guten Kontrast und einen neutralen Sichtbereich. 

● Looks Browser: Die Teams von Skylum und professionelle Fotografen haben 
Voreinstellungen erstellt, um mit einem einzigen Klick beeindruckende Bilder zu liefern. 
Jede Voreinstellung besteht aus der Anwendung eines oder mehrerer nativer Tools in 
Luminar 3, sodass jeder Nutzer seine eigenen mit den systemeigenen Funktionen der 
Software erstellen kann. 

● Looks-Kategorien-Browser: Klicke auf das Popup-Menü links im Luminar Looks 
Browser, um die Kategorien zu ändern. 
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Bearbeitung 
Rundgang  
Luminar 
Rundgang 

Eine kurze Anleitung zum Importieren, 
Bewerten und Organisieren von Bildern. 
Du lernst auch, wie du ein Foto mit 
Arbeitsbereichen und Filtern bearbeitest. 

Jetzt ansehen 

Produktü
bersicht 

Ein ausführliches Briefing zu Luminar. 
Erfahre, warum Luminar 3 funktioniert 
und, wie künstliche Intelligenz deinen 
Arbeitsablauf rationalisieren kann 

!    Jetzt ansehen 

Hands-On-
Dateien 

Wir haben eine Sammlung von 
Beispielfotos zusammengestellt, die du als 
Screenshots oder Videobewertungen 
verwenden kannst. 

HERUNTERLADE
N 
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https://youtu.be/8G-
S8rqs0ZU

https://youtu.be/g5n0_zcxFvY
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https://www.dropbox.com/sh/vzskbi2jbgeptwg/ 

AAAt3tthKnvGxjALAKhIuyVMa/Sample%20photo%20gallery?dl=0

http://www.dropbox.com/sh/vzskbi2jbgeptwg/
http://www.dropbox.com/sh/vzskbi2jbgeptwg/


Medienkontakt 
MARIA GORDIENKO 
MARIA@SKYLUM.COM

mailto:MARIA@SKYLUM.COM

